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Introduction 

Welcome to Commando. 
 
Commando is a program to save and restore Command Station settings.  You can backup 
your settings for later restoring, or save several files for different operating sessions.  It 
can also be used to change those settings.  If many Macros are utilized, Commando shows 
each macro, and it’s counterpart, at a glance. 
 
The user interface is arranged as a set of Tabs on the main dialog.  In Windows 95 these 
are known as Property Pages.  Click on the Title (the Tab) of the page to bring it to the 
front.  Now you can view and change the setting for that page. 
 
When Read is pressed, the settings are read for all of the pages, except for Assign Loco to 
Cab.  When Send  is pressed, the settings on all of the pages are sent to the Command 
Station pages, except for Assign Loco to Cab. 
 
Assign Loco to Cab is an action to be performed, not a specific setting.  Enter the Loco 
Address, the Cab Address, and press Assign. 
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System Requirements 

 

Requirements Minimum Recommended 

Processor 80286 80386 or better 

Operating System MS DOS 3.1 / Windows 3.1 or 
Windows 95 

MS DOS 6.5 / Widows 
3.1 (Commando will 
run on Windows for 
Workgroups and 
Windows 95) 

Hard Disk Space 500K bytes 500K bytes 

Floppy Disk 1 - 3.5” 1.44MB high density  

System Memory 2MB (8MB for Windows 95) 4MB 

Mouse Any supported by Windows  
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Installation 

Commando is supplied with a standard Windows setup program that copies the files 
off of the installation disk and places them in the correct places on your hard disk. 
Follow the instructions below.  If you are updating from a previous version, see that 
section below. 

 
1. Insert the Commando disk in the 3.5”  disk drive. 

2. From the File menu in the Windows Program Manager, File Manager, or Start 
button, choose Run. 

3. Enter A:\Setup (substitute a different letter for A if you are installing from 
another drive), or press the Browse button and find the installation disk and the 
program called setup.exe. Press OK on the Run dialog. 

4. Follow the instructions presented to install the program to your hard drive. 

5. Installation is now complete. 
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 Connection to SystemOne 

Cable 

You can use a Male 9 pin D connected to a Female 9 pin D with ribbon cable, or use a 
9 pin D extension cable. A 9 to 25 pin adapter at the computer end will work if the 
computer you are connecting to does not have a 9 pin D port. 

  

 

1
2*
3*
4
5*
6
7
8
9

1
2*
3*
4
5*
6
7
8
9

DB9-S to computer DB9-P to Command
Station  

 

Note: The signals marked with an “*”  are the only ones that are necessary. 
 

Communications 

Commando communicates at 9600 baud. Make sure that the Command Station is set 
to 9600 baud (Factory Default. See “Getting to Know your Command Station”  
section). The rest of the communications parameters are 7 bits, even parity, and one 
stop bit. 
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Common Page Controls 

 

Command Station SW Version 

When the Read button is pressed, the version string is read from the Command Station 
and displayed here. 

Progress 

This progress bar will show the amount completed for Read, Send, a File I/O 
operations. 

Read 

Pressing this will cause Commando to get the current values from the Command 
Station. Assign Loco to Cab values are not read. 

Send 

Pressing this will cause Commando to store the displayed values in the Command 
Station. Assign Loco to Cab values are not stored. 

File Menu 

Use this menu to open or save files, set preferences, and exit the program.  For more 
information, see the File Menu Topic. 

Help Menu 

Use this menu to view this help file or to display the About dialog.  For more 
information, see the Help Menu Topic. 
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Assign Loco to Cab 

Select the Assign Loco to Cab Tab to view this page. 
 

 

Loco Address 

Enter the address of the Loco that you want to Assign to a Cab. 

Cab Address 

Enter the address of the Cab that you want to Loco Assigned to. 

Assign 

Pressing this button assigns the Loco Address to the Cab Address.  Note that because 
Assign Loco to Cab is an action, no data is read when the Read button is pressed.  By 
the same token, no data is sent when the Send button is pressed. 

Use Long Addresses 

If this is checked, addresses below 128 will be sent as long addresses.  If not checked, 
addresses below 128 will be sent  short addresses. 



Page 9 or 21 

Set Clock 

Select the Set Clock Tab to view this page. 
 

 

Hours 

This is the Fast Clock Hours. The Fast clock will be set from this when the Send 
button is pressed. The hours will update approximately twice a second. The Fast clock 
will be read when the Read button is pressed. 

Minutes 

This is the Fast Clock Minutes. The Fast clock will be set from this when the Send 
button is pressed. The minutes will update approximately twice a second.  The Fast 
clock will be read when the Read button is pressed. 

Ratio 

This is the Fast Clock Ratio.  The range is from 1:1 to 25:1.  Note that some ratios are 
not possible due to rounding, the final ratio is the integer portion of 250 divided by the 
entered Ratio. The Fast clock will be read when the Read button is pressed.  The Fast 
clock will be set from this when the Send button is pressed. 



Page 10 or 21 

12/24 Hour 

This is the Fast Clock 12 or 24 hour setting.  The Fast clock will be read when the 
Read button is pressed.  The Fast clock will be set from this when the Send button is 
pressed. 

AM/PM 

This is the Fast Clock` AM or PM hour setting.  This setting is only available if the 
12/24 Hour is set to 12 Hour.  The Fast clock will be read when the Read button is 
pressed.  The Fast clock will be set from this when the Send button is pressed. 

Hold 

This is the Fast Clock Hold setting.  If this is checked the Fast clock will hold the 
value set in Hours and Minutes settings.  The clock will re-start if this is un-checked 
and the send button is checked.  The Fast clock will be read when the Read button is 
pressed.  The Fast clock will be set from this when the Send button is pressed. 

Set Clock to PC Time 

Pressing this button will set the clock in the Command Station to the current PC time.  
It also sets the Ratio to 1 and the 12/24 Hour mode to 24 Hour. 
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Macros 

Select the Macro Tab to view this page. 
 

 

Macro Number 

Enter the number of the Macro that you want displayed in the list below.  Type the 
number directly in the box, or select it from the drop-down list.  When the number is 
changed in left box, the right box will be updated to the number entered plus the 
Macro Number Offset  

Macro Number Offset 

There are two Macro lists displayed.  If your Macro has a normal and a alternate 
route, it is convenient to number the normal route in the 0-99 range, and the alternate 
route in the 100-199 range.  This box holds the offset between the list on the left and 
the list on the right (default 100).  Type the number you use between the normal and 
alternate routes.  This number will only be saved when the Preferences are saved. 
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Macro Address 

This is the address of the accessory that you want to change.  The direction is set with 
the Macro Output. 

Macro Output 

This is the direction that will be output to the accessory.  The address of the accessory 
is set with the Macro Address .  You can change the labels that appear in this list in 
Preferences. 
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Command Station 

Select the Command Station Tab to view this page. 
 

 

Highest Cab Number 

This adjusts the number of Cabs that the Command Station will poll.  This number 
should be set as low as possible but still poll all of the Cabs in use.  This factory 
defaults to 11.  TIP: It is faster to poll a connected Cab than it is to poll a non-existent 
Cab.  To avoid this situation, consecutively number the Cabs from 1 to N, and set the 
HIGHEST CAB NUMBER to N + 2. 

Highest Cab to Program on Main 

This sets the highest Cab address that will be able to Program on the Main.  Cabs 
above this setting will skip the PROGRAM ON MAIN menu selection.   0 = all Cabs. 

Highest Cab to Assign Loco 

This sets the highest Cab address that will be able to Assign Loco to Cab.  Cabs above 
this setting will skip the ASSIGN LOCO->CAB menu selection.   0 = all Cabs. 
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Highest Cab to Set Clock 

This sets the highest Cab address that will be able to Set the Clock.  Cabs above this 
setting will skip the SET SYSTEM CLOCK menu selection.  0 = all Cabs. 

Highest Cab to Use Program Track 

This sets the highest Cab address that will be able to Use the Program Track.  Cabs 
above this setting will skip the USE PROGRAM TRK menu selection.  0 = all Cabs. 

Highest Cab to Set Command Station 

This sets the highest Cab address that will be able to Set the Command Station.  Cabs 
above this setting will skip the SET CMD STATION menu selection.  0 = all Cabs. 

Highest Cab to Set Itself 

This sets the highest Cab address that will be able to Program the Cab Parameters 
(itself).  Cabs above this setting will skip the SET CAB PARAMS menu selection.  0 = 
all Cabs. 

Highest Cab to Program Accessories 

This sets the highest Cab address that will be able to Program Accessories.  Cabs 
above this setting will skip the PROG ACCESSORIES menu selection.  0 = all Cabs. 

Highest Cab to Program Macros 

This sets the highest Cab address that will be able to Program Macros.  Cabs above 
this setting will skip the PROGRAM MACROS menu selection.  0 = all Cabs. 

Number of Recalls 

This adjusts the number of Loco’s that are cycled through when the RECALL key is 
pressed.  Enter the number of Recalls from 1-6. 

Number of Stop Packets 

This adjusts the number of packets sent when a stop command is sent to the Loco. 

Number of Temp Packets 

This adjusts the number of packets sent when a temp (such as Functions On/Off) 
command is sent. 

Number of Accessory Packets 

This adjusts the number of packets sent when an accessory command is sent. 

Number of Horn Loops 

This adjusts the number of times around the Cab poll loop that the Horn command is 
checked. 
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Number of Program Packets 

This adjusts the number of packets sent when a programming command is sent to the 
Loco. 

Test for Loco in Use 

If this is checked, a warning will be issued to the operator if a Loco is selected that is 
in use by someone else.  If not checked, no warning is issued. 

Accessory Refresh Rate 

This controls the rate at which Function Group One (F0-F4) packets are repeated on 
the rails after the "normal" number (TEMP PACKETS) of times. When set to zero, 
the function packets are never repeated. If non-zero, Function Group One packets are 
generated and sent out over the rails for the currently active locomotive on each cab.   
The rate of sending these packets is approximately .004 * n seconds (where n = value). 
Example: n = 250 refreshes all function group one packets about 1 second.  NOTE: 
This should only be used when using Decoders which do no remember the Function 
status after a power interruption.  When used, the number should not be set below 
200. 
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Cab Parameters 

Select the Cab Parameters Tab to view this page. 
 

 

Cab Address 

This is the Cab that is to be assigned the Horn and Bell function number. 

Horn Function 

This is the function output that is connected to the Horn Output. 

Bell Function 

This is the function output that is connected to the Bell Output. 

Set All Cabs = to Cab 1 

Use this button if you want to rapidly set all of the cabs to the same Horn and Bell 
functions.  Set Cab 1’s functions, and then press this button. 

Scroll Bar 

Use this scroll bar to view and set the rest of the cabs. 
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Loco Alias 

Select the Loco Alias Tab to view this page. 
 

 

Short Address 

This is the Loco Short Address.  There are 127 addresses, from 1 to 127.  This filed is 
not editable.  Use the Scroll Bar to see all of the Locos. 

Long Address 

This is the Long Address that the Short Address on the left is assigned to.  Select the 
Long Address box to the right of the Short Address that is to be alias’d, and enter the 
address.  After the address is assigned and sent to the Command Station, selecting a 
loco using the Long Address will internally select the Short Address. 

Search 

Use this to find a Long Address in the Alias table.  Enter the Long Address in the edit 
box and press the Search button.  The cursor will be placed on the corresponding 
Long Address. 

Scroll Bar 

Use this scroll bar to view and set the rest of the Locos. 
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File Menu 

Use this menu to open or save files, set preferences, and exit the program. 

Open... 

This menu item will open and display an existing Commando file. 

Save 

This menu item will save the currently open file.  If no file is open, the Save As... 
operation will be used. 

Save As... 

This menu item will save the displayed value to a new file. 

Preferences... 

This menu item will open the Preferences dialog. 

Exit 

This menu item will close the program and return to Windows.  If the displayed values 
have not been saved, the Save As... dialog will be displayed to let you save the file. 
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Help Menu 

Use this menu to view this help file or to display the About dialog. 

Help Contents... 

This menu item will display the Commando Help file. 

About... 

This menu item will display the About dialog. 
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Preferences 

 

CommPort 

This is used to set the communications port to COM1, COM2, COM3, or COM4. If 
the currently selected communications port is being used, an error dialog will be 
displayed and you should choose a different communications port. 

Baud Rate 

The Baud Rate can be 1200 or 9600. 9600 baud is the default for SystemOne and for 
Commando. 

Macro On Label 

The labels for the Macro output direction can be set to any text that makes sense for 
your situation.  You can type text (up to 8 characters) into the box, or select one of 
the pre-defined label in the drop-down list.  When you select a pre-defined labels, the 
corresponding companion label will be automatically selected in the Macro Off Label.  
If you type in the box, the Macro Off Label will be cleared. 

Macro Off Label 

The labels for the Macro output direction can be set to any text that makes for your 
situation.  You can type text (up to 8 characters) into the box, or select one of the pre-
defined label in the drop-down list. 
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About 

 

 

 

Displays an information dialog showing the product name, author, revision number and 
kudos for my beta testers.  Click anywhere on the dialog to dismiss it. 


